Microsoft FRONTPAGE and HTML

A Quick Reference Guide
Copyright 2002 by Michael Carlson Kapper

Using Frontpage to Build Web Nodes — The Basics
This section covers the basics of using Microsoft Frontpage to create web nodes. While
there are many more advanced features you could use, these basics will get you started.

To Create a New Web Node (Page):
Select New from the File menu, or click on the New o - icon on the tool bar.
You will have the option of creating a new web page or an entire new
web site. Most times it will be in your best interest to create a single page, but if
you choose to create an entire site, Frontpage has Wizards and Templates to help you
in this process.

To Edit an Existing Web Node (Page):
Select Open from the File ment, or click on the Open gz . icon on the tool bar.
Locate the file you wish to open on your hard drive, home directory (h:\
drive), or disk (floppy or ZIP) and click on the “Open” button.

To Change the Background, Text, or Link Colors:
Choose Background from the Format menu. In the area highlighted by the red box
in Figure 6 below are the five color selections used to define the initial properties of
each web page.
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Figure 1. FrontPage color selections.

The group of two options on the left are the background and text colors — these
define the color of the background (the defaultis white) and “ordinary,” non-linked
text (the defaultis black). The group of three options on the right control the colors
of text hyperlinks in their various stages. The “Hyperlink” color is the color of a
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hyperlink that has never been followed (the default is blue). “Visited hyperlink”
color is the color of a hyperlink that has been followed (the default color is purple).
“Active hyperlink” color is the color of a hyperlink that is currently being followed
(the default color is red). Click “OK” when you're done.You can set these colors to
many different shades.

To Use a Background Image
Choose Background from the Format menu. In the area highlighted by the red box
in Figure 7 below, check the box next to “Background Picture.” In the textbox next
to the “Browse” button, type the location of the file you wish to use as a background
image. Alternatively, click on the “Browse” button to browse your hard drive,
home directory, or disk for the file. When you have selected a file, click “OK” to
close the window.
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Figure 2. Inserting background images in FrontPage.

To Insert an Image (.gif or .jpg file):
Move the cursor to the spot you want your image to appear. Select Picture from the
Insert menu, and choose either Clip Art or From File. If you choose Clip Art, browse
for the Microsoft Clip Art you want to use, click on the image, and select
“insert”from the pop-up menu. If you choose From File, browse for the file you
want to use and click the “OK” button when you have selected the image you want.

A word on graphics file formats. The two most commonly used formats are GIF
(Compuserve Bitmap, file extension: “.git”) and JPEG (Joint Photographic Expert
Group bitmap, file extension: “.jpg”). The biggest difference is that the JPEG format
was designed to digitize color photography; as such, it can handle millions of colors
and great resolution, but it’s “lossy,” which is to say that the more you compress a
JPEG, the more information (color data, image sharpness) it loses. GIF images, on
the other hand, can handle only 256 colors per image (but these can be any 256
colors, not a predetermined set); GIFs, though, compress better, with less loss, than
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do JPEGs. A general rule of thumb, use JPEGs for color photography, use GIFs for
everything else.

If you want to create an “alternate text” for an image you’ve inserted (which will
display incase your image does not load, click on the image in the editor window
and press [ALT]+[ENTER]. In the “Text” box (highlighted in the red box in Figure
8 below) under Alternative Representations, type a brief description or label of the
image (three or four words max). Click the “OK” button.
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Figure 3. The FrontPage Picture Properties Box.

To Insert a Hyperlink:
Highlight the text or select (click on) the graphic you wish to use as a link. Select
Hyperlink from the Insert menu, or click on the Hyperlink button on the toolbar, or
press [CTRL]+K. In the URL box (see Figure 9 below), type the URL for the
webpage you want to link to (for example,_http://owl.english.purdue.edu/ or
http:/ /icdweb.cc.purdue.edu/~[youralias]/pg2.html. Click the “OK” button.

To Link to a Word (.doc or .rtf) or Acrobat (.pdf) File:
You can publish Microsoft Word (.doc or .rtf) and Adobe Acrobat documents
(files) to the web and link to them from your web node. First, save the document
in your www directory. Second, in your web node, type the text or insert the
graphic you would like to use as the link to the document. Follow the procedure
for a hyperlink explained above. Then in the URL box, type the file name of the
document you’re linking to (for example, filename.doc or filename.pdf). Click the
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Figure 4. The hyperlink dialogue box.

Advanced Features of FRONTPAGE

The previous section dealt with the generalities of creating hypertext documents in Microsoft
FRONTPAGE, and the basic features of hypertext documents. This section deals with the
theory of more advanced hypertext design and the practice of implementing that design in
FRONTPAGE.

Tables

FRONTPAGE allows you to insert tables into your web pages. Now, this may not seem like
all that advanced a feature, or one that you're likely to make much use of. Remember,
though, that in designing documents (both hypertext and — in some cases — print, as
well), tables can be used for more than presentations of data (their most traditional use).
Tables can be a powerful layout and design tool for hypertext; they can be used to:

. Present data in an easily scanned row/column index format.
. Lock the display size of hypertext documents.
. Help organize text and graphics on the screen, and help to keep them

from moving in relation to one another.

The first use mentioned above is the traditional use, and should be relatively obvious.
From presenting data you’ve collected and tabulated to creating an on-line calendar, the
traditional use of tables to present data in row/column format is a prevalent use of tables
in hypertext.

In addition to this traditional use, however, we can use tables in our hypertext
documents to lock-in the display size of our content. You have no doubt seen web sites
that tell viewers that the content is best viewed in some resolution or another (say, 640x480
or 800x600). In these cases, the second number means very little, because it is the height
of the screen in pixels, but having to scroll vertically is no big deal to us, because it
reminds us how we normally absorb information — by looking down the page! The first
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number, though, has to do with the width of the screen in pixels (the little dots that make
up monitor resolution). This is important because all monitors (or other computer display
devices) are made up of a set number of pixels — there is an upward limit to the width of
the content they can display. The bottom line here is that without some way of setting
content width for your pages, your viewer will see your content condensed or expanded
to fit the width of their browser window or their computer screen. But here’s the catch:
if you set a width for your content that is wider than their display is capable of — say you
set your content at 1024 pixels wide, and their monitor can only display 800 pixels, the
viewer will have to scroll horizontally to view all of your content (and the same is true of
content at 800 and display at 640). Most new display devices now are capable of resolution
of 1024 pixels, but not everyone has these devices yet. To be safe, you should set your
content width at about 800 pixels. The way you do this is to put your content on a table,
which you can set to 800 pixels wide. Then, whether the viewer’s display is set for 640,
800, 1024, or something else, your content will always be displayed at 800; this will make
the 640 user have to scroll left to right, but it will keep your content from being smooshed
into 640 pixels and from being expanded into 1024 — in short, your content will display
as you laid it out, every time!

In addition to this size factor, you can also use a table to locate text and graphics
(and other hypertext elements, as well) in relation to each other. For example, if you insert
a graphic in-line with text, hypertext assumes that the bottom of the image should line up
with the bottom of the text. If you want your text and image to line up differently (say, the
tops line up or the text is centered on the image), you can best achieve this by putting the
image in one cell of a table and the text in the cell next to it and adjusting the position of
the text within its cell.

To insert a table, select the Table menu. From the menu select Insert and then Table.
The following dialogue box will appear to help you set up your table:

This dialogue box asks you first to set up the number of rows and columns for your
table. This is a spot where it might be handy to have made a sketch of your node, so you
know how many you’ll need (remember, if there are spots in which you need more or less
than in other sections of your node, you can merge the cells together or split them apart
as needed — it’s usually best to start with the highest number of rows and columns you
foresee needing and to merge from there).

Next, you'll note the “Layout” section of the dialogue box. On the left-hand side
here are the general layout features for your table. The “Alignment” drop-down menu
allows you to set every cell in your table to “Left,” “Right,” or
“Center” alignment — if you don’t want them all the same, :
don’t worry, you can change them individually later. F— Bt
The “Border Size” box allows you to specify the width of the | = F = = & 4
cell borders for your table. The higher the number, the thicker | .  fows sl @m0 -
the line (entering zero (0) here will give you a table with | 57> lt:i "
invisible borders). “Cell Padding” refers to the number of | @== F =
pixels between the cell contents and its borders. “Cell |=
Spacing” refers to the number of pixels between cells in the | “™“ "™ -
table. Cell padding and cell spacing can be useful especially S e
when using a table with invisible borders to provide Figure 5. The table dialogue.
delineations between the contents of various cells.
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On the right-hand side of the “Layout” section is the “Specity Width” check box.
If this box is checked, you'll be able to select the width of your table (its height will be
governed by its content). You can select this width in percentages of the screen width, or
in pixels (which is how we said we lock the width of our display). If you choose
percentages, be sure you've entered a number from 1 to 100 (a table set at, say, 800% of
screen width just gets out of control). If you choose pixels, the sky’s the limit, but
remember that most people still count on web resolution of 1024 pixels or less, with 800
pixels or less being safer.

After you've set up your table, you can insert text, graphics, and hyperlinks into
your table as you would into anode without a table. You can also use other options on the
Table menu to modify your table.

. Merge cells. 1f you have highlighted two or more contiguous cells, you
can merge them into one cell with this command.
. Split cell(s). One or more cell(s) can be split into one or more row(s)

or column(s) with this command.

. Table Properties — Cell. This will allow you to change the properties
(border color, background color, etc.) of one or more cell(s) in your
table.

. Table Properties — Table. Applies the changes you make (to border
color, background color, etc.) to the entire table.

. There are other options on the Table menu — if you're interested in
advanced table features, you should spend time exploring these.

Remember, the technique of using tables as a layout tool can be as useful in the production
of print documents as it is on the web.

Frames

Using frames allow you to divide your viewer’s browser window into several smaller
viewing areas. The idea is that you can have some content that remains static while other
content changes in the same window; this means, as well, that the content in all of your
frames can change independently — if you have three frames, the content in two of them
can remain the same while the third changes, or they can all three change at once, or any
link in any of the frames can change the content in that frame or any of the others. Frames
allow you a great deal of flexibility regarding how your content will be displayed.

The other concept integral to the idea of frames is that of the frameset. A frameset
is the web node (or html page) that controls the layout of the frames, what content nodes
(or pages) are initially displayed, and how the frames relate to one another. The frameset
sets the sizes of the frames, and — in essence — controls the whole show as far as
displaying framed content.

Creating a Frameset. In Microsoft FRONTPAGE 2002 (FRONTPAGE 2000 is different),
begin by selecting the File menu. From the File menu, select New. From the submenu that
appears, select Page or Web. This will display a variety of choices on the right hand side
of the screen. From these choices, select Page Templates (shown in Figure 6 below).
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Figure 6. The “New Page or Web” Menu Listing.

When you have clicked on Page Templates, the dialogue box for templates will appear (see
Figure 7 below). Select the “Frames Pages” tab (indicated by the maroon arrow in Figure
7 below). Then select the type of frameset you would like to work with (each is previewed
as you single click on it, indicated by the blue arrow in Figure 7 below). Clicking the “OK”
button selects the highlighted frameset template, and FRONTPAGE will build your frameset
and so that you can begin editing content.
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Figure 7. Frameset template selection
dialogue.

This array of templates allows you to created ten different styles of framesets. The
specifications of these framesets are detailed below:

. Banner and Contents. This provides a three-way split of the screen,
with a short top frame running the width of the screen (a “banner”
frame), a narrow frame running the remaining length of the screen at
the left-hand side of the screen (a “contents” frame), and the
remainder of the screen to contain the content. The idea here is that
the banner frame will remain totally static as the site is viewed, while
the contents frame will be used to navigate the content displayed in
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the third frame.

Contents. This is a two-way split; it is similar to “banner and
contents” minus the banner.

Footer. The footer frameset is a two-way split of the screen, with a
short bottom frame running the full width of the screen. The idea is
that you can display a footer (perhaps a bottom banner) of static
content in this space.

Footnotes. This frameset bears a striking resemblance to the “footer”
frameset. The main differences are: 1) the bottom frame is taller in
the “footnotes” frameset, and 2) intent: the idea is that this bottom
frame will display footnotes to the content displayed in the main
frame above it. In this instance, the content of both frames in the set
is meant to be dynamic. (See http://icdweb.cc.purdue.edu/
~kapper/scholarship/archive/624/index.html for an example of this
type of frameset.)

Header. The “header” frameset has a short frame at the top which
runs the entire width of the screen.

Header, Footer, and Contents. This frameset includes both a header and
a footer (short frames running the entire width of the screen). It also
includes the narrow frame at the left-hand side of the page running
from header frame to footer frame.

Horizontal Split. This frameset includes two equal frames, displayed
top and bottom.

Vertical Split. This frameset includes to equal frames, displayed left
and right.

Nested Hierarchy. This frameset includes a narrow frame at the left-
hand side of the screen running the full top-to-bottom length of the
screen, then two other frames splitting the remaining space of the
screen horizontally; the top screen of these two will be shorter than
the bottom. The idea behind this frameset is that the left frame will
display general contents, which will control the top frame which
displays more detailed contents and will in turn control the bottom
frame which will display content.

Vertical Hierarchy. This frameset functions along lines similar to that
of the “nested hierarchy” except that this frameset contains three
horizontal frames. The top frame is for general contents, the middle
frame for detailed contents, and the bottom frame for actual content.
Bear in mind that the template sets up not only the layout of the
frames, but also certain default ways in which they relate to one
another. For example in either “hierarchy” type of frameset, alink on
a page in the general contents frame will — by default — attempt to
display another page in the detailed contents frame. Consider this
carefully as you create your frames.
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I've Got a Frameset . . . Now What? Once you've chosen the type of frameset you
would like to insert and FRONTPAGE has set it up for you, you will find that you are faced
with a frameset devoid of content (as shown in Figure 8 below). At this point, you must
either insert or create the content nodes for your frameset.
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Figure 8. An empty “Banner & Contents” Frameset.

You will note that each frame in the empty frameset has two buttons in it. One says “Set
Initial Page”; by clicking this button and following the prompts, you will be able to choose
an existing node you have already created to display in this frame. The other button says
“New Page”; by selecting this button, you will create a new, blank web node in that frame,
which you may then edit as you would any other FRONTPAGE document.

If you have not prepared any of your content ahead of time, you will select “New
Page” for each frame (shown in Figure 9 below). You will then edit each frame’s page
individually by clicking on it.
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70 seconaz cverzo0 »

Figure 9. A Frameset with all new nodes.

To select a frame or the page it contains, click anywhere within the frame — the frame
becomes the active frame and the page it contains becomes the active page. After you have
selected a frame and its page, you can edit the page as you normally would; you can also
edit the properties of the frame. To do this, right click anywhere in the frame and select
Frame Properties from the menu that appears. The “Frame Properties” dialogue box will
appear.
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Figure 10. The “Frame Properties” dialogue.

This dialogue box allows you to set the properties of the current active frame. The “Name”
box allows you to name the frame — each frame’s name will be important when you try
to open pages in different frames, so name you should name your frames intuitively, or
simply use the names the template gives them (and write down which is which). The
“Initial Page” box lists the file that is opened in this frame when the frameset is opened;
the “Browse” button here allows you to choose a different file. The “Frame Size” section
allows you to resize your frame, and the “Margins” section allows you to control how close
page content will be allowed to come to frame edges in pixels. The “Options” section
allows you to set up other features of your frames. The “Show Scrollbars” drop-down is
perhaps the most important of these; if you know that a frame’s content will fit the frame
without scrollbars, you may select never. If you are unsure as to whether a frame’s content
will fit without scrollbars, you should select If needed. There is really not a reason to ever
select always, because this will cause scrollbars to be displayed even if they are not needed,
and unnecessary scrollbars look unprofessional and serve only to clutter the frameset.

Saving your Frameset. The first time you save a frameset in FRONTPAGE, you will be
prompted with the “Save as” dialogue box for each unsaved element of your frameset (the
frameset itself, and any nodes/ pages you have created within the frameset that are, as yet,
unsaved. Be sure, as you go through this process, that you pay attention to the highlighted
frame/frameset in the dialogue box so you know which portion (a page or the frameset)
you are currently saving (see Figure 11 on next page). Be sure that you name the pages
intuitively, of course, and remember that if the frameset is to be the first node displayed
in a site or subdirectory, you might want to name it “index.htm” or “index.html” within
that site or directory.
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Figure 11. The Frameset “Save As” dialogue.

Note in Figure 11 above, that the arrow points to the selected frame. This dialogue box will
save the page that you have created in this frame. If you have created a new page in each
frame, you will receive a dialogue for each frame and one for the frameset as a whole.

Linking to other Pages in a Frameset. So, now you have created your frameset, and
you have set up an initial page to display in each frame. How do you go about changing
the content in a frame or two? The first step is just like it would be in any other
circumstance — you enter the text or graphics you want use as a link in one of the pages
currently displayed by your frameset. Then you begin the process for inserting a
hyperlink (as normal). When the hyperlink dialogue box is displayed (see Figure 12
below), enter the file you want to link to in the “Address” box, but before you click “OK,”
click on the “Target Frame” button, to control which frame your link will be displayed in.
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Place in This new_page_7.htm {unsaved)
Documen t Browsed [ _private F——

Figure 12. The Hyperlink dialogue.

When you have clicked on the “Target Frame” button, the “Target Frame” dialogue box
will be displayed (see Figure 13 on the next page). This dialogue box will contain a
thumbnail drawing of your current frameset (on the left-hand side) and a listing of
common targets (on the right-hand side). You may select any frame in your current
frameset simply by clicking on the frame in thumbnail; this will select that frame as the
target for your link, and you can then click the “OK” button to close the dialogue box.
Clicking on any of the options in the “Common Targets” section will allow you to control
the target of your link to locations other than the frames in your current frameset.
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Figure 13. The “Target Frame” dialogue.

The “Common targets” settings are described below:

Page Default (main). When we selected the “Banner and Contents”
template as we set up our frameset, the default target for links
anywhere in this frameset was set to “main” (the bottom right frame
in the frameset). This was done because in this type of frameset, it is
assumed that most of the content is going to be displayed in this
frame. If you do not specity a target for a link in your page, its target
will be this frame. If you wish to change the page default, choose
what you want the new default to be (either in the thumbnail or
among the common targets), check the “Set as page default” box, and
click the “OK” button.

Same Frame. This makes the target frame the same as the frame
containing the link. If you apply this target to a link in the “contents”
frame (the lower left-hand frame), the new page will open in that
frame, replacing the previous content (this is handy for making
contents lists expandable; see http:/ /ssinfo.purdue.edu/).

Whole Page. This target replaces your entire frameset with the content
itis linked to. The entire browser window will be taken up with the
node this link points to.

New Window. This target opens a new browser window for the
content of the linked node. The frameset remains available in its
browser window, and the new content becomes available in a
window of its own. This is especially useful when your frameset
includes links to sites outside of your frames-based site. It is
imperative that you use either “Whole Page” or “New Window” when
linking to sites outside of your frames-based site.

Parent Frame. This target is useful when you have “nested framesets”;
that is, when you have a frameset opened within a frame of another
frameset. This target allows you to replace an entire frameset in a
frame of another frameset with the new node’s content. If you have
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only one frameset in a page, this target is equivalent to the “Whole
Page” target.

Remember that frames can be a dynamic way of displaying multiple content nodes
simultaneously. More than with straightforward hypertext, however, you must be certain
that navigation of your frames and framesets is intuitive and not confusing.

Other Links: Email Links and Bookmarks

In FRONTPAGE, you can link to things besides other files, nodes, or sites. You can also use
a hyperlink to send an email message or to jump to a specific point within the text of the
node that is currently displayed. These actions are controlled from the “Insert Hyperlink”
dialogue box.
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Figure 14. The “Insert Hyperlink” dialogue.

Note, in Figure 14, the two arrows indicating selection buttons along the left-hand edge of
the dialogue box. The maroon arrow indicates where you would click to link to a bookmark
in the same document, while the blue arrow indicates where you would click to create a
link that sends an email to a specified address.

Email Links. After you have inserted and selected text or graphics for the link,
opened the “Insert Hyperlink” dialogue, and clicked on the “E-mail Address” selector, the
dialogue box will change.
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o) E-mai address:
Existing File or "

web Page
Subject:

§]
Place in This  Recently used e-mail addresses:

Document [mailto:kapper@pur due. edu?subject=ihat are you looking at -] Parameters...
Style..

Create New
Document

|
Cancel

£-mall Address

Figure 15. The Email link dialogue box.

You can enter the email address you want to send a message to in the “E-mail address”
box. (Don’t be alarmed when FRONTPAGE adds “mailto:” before the email address you
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enter.) If you would like to specify the subject of the email that this link would send, enter
that subject line in the “Subject” box. Then click on the “OK” button.

Bookmarks. 1f you want your audience to be able to navigate your nodes through a
system of bookmarks and internal links, you can set this up. Select the places in your
nodes that you would like for the audience to be able to “jump” to. First, position your
curser in each of these places, and then click on Insert, then Bookmark. You will be
prompted to name the bookmark you're inserting; bookmark names should be intuitive
— they should relate to what they mark.

After you've inserted the bookmarks into your node, follow this procedure to link
to them. Insert and select the text or graphics you wish to use as the link. Open the “Insert
Hyperlink” dialogue box and click on the “Place in this Document” selector (the “Insert
Hyperlink” dialogue box will change).

R ?[x]
Link to: Text o display: [Link #1 SereenTi. ..
B Select a plae in this document:
Existing File or [ = Bockmarks
ek Page bhnkd
Target Frame. .
Place in Thi
Documen t
& Stye..,
Craate lew
Docurnen 3
E-mail Add
Cancel

Figure 16. The bookmark link dialogue box.

All of the bookmarks inserted in the node will be displayed in the “Select a place in this
document” box. You can select the bookmark and then click the “OK” button; this will
insert a link to that bookmark on the present page. Be sure, if you are working with frames,
to use the “Target Frame” button to select the frame that the node you're working with
appears in, or the page you're working with will display itself and jump to the bookmark
in the page default target frame.

Bookmarks and email links allow you to diversify the content and capabilities of
your web pages. They, especially bookmarks, allow easy navigability, but remember that
bookmarks must have links to them to be useful and too many links to bookmarks can
clutter your nodes — this is not to say “don’t use them,” but rather to caution that you
should strike a balance here.

Hotspots
In addition to linking to a section of text or to a whole graphics image, you can insert
hotspots on a graphics image to allow you to link to a specific portion of that image.
Inserting hotspots is also known as generating an image map for the graphics image in
question.

To generate an image map and place hotspots in it, you should first insert the image
in your node as normal. Once the image is inserted, click on it to select it. You will note
that the Picture toolbar (denoted by the green arrow in Figure 17 below) becomes active.
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This allows you to insert hotspots (circular, rectangular, or polygonal) into the image map

that overlays the graphics image.

Jiely a0 e Frusiibeg - € Ue nleiits b Seiiafss O ol Uy Lo ety i A3 s/ pege i [- [8]x]
Fle Edit Yiew Insert Format Tools Table Frames Window Help mmon frame targsts -
OD-=-H82 B- &4V §BR S - EEE S R T e,

+ Times New Roman s3(lzpyr B I U E=E = A s EIEEE O A
/new_page_Shtm* Y, x

file: J§/C: iDocuments and Settings/Owner/My Document ts/My WWebsinew_page_1.htm

v x

¢ ul @l = kO o X% |

Cdhormal EIHTML Q.Preview | ‘

I =22 seconds over 288

Figure 17. Image maps and hotspots.

The button for a rectangular hotspot on the “Pictures Toolbar” is
indicated by the maroon arrow, as is the rectangular hotspot on the
image that results from it. To insert a rectangular hotspot, click on the
rectangular hotspot button then drag to draw the hotspot on the image
from one corner to the opposite corner diagonally.

The button for a circular hotspot on the “Pictures Toolbar” is indicated
by the blue arrow, as is the circular hotspot on the image that results
from it. To insert a circular hotspot, click on the circular hotspot
button then drag to draw the hotspot on the image from the center of
the circle to the outside edge.

The button for a polygonal hotspot on the “Pictures Toolbar” is
indicated by the orange arrow, as is the polygonal hotspot on the
image that results from it. To insert a polygonal hotspot, click on the
polygonal hotspot button then draw the hotspot, clicking once on the
image for each corner of the hotspot. Be sure to close the hotspot.

In each case above, when you have finished drawing each hotspot, the “Insert Hyperlink”
dialogue box will open and you will be prompted to provide hyperlink information for

each hotspot. These can link to other nodes, to bookmarks within the same node, or to
email addresses. Be sure when you use image maps and hotspots that you somehow make
clear that the image map is to be used for navigation — you might state this and also
provide text hyperlinks as a backup approach to navigation. In short, be sure you have
used the image map to enhance the navigability of your site, not to detract from it.
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Timestamp

The timestamp feature is a great way for those of us who are sometimes forgetful about
adding (or updating) a date to our web nodes (“this node last updated . . .”). This feature
allows you to insert the date and time into a page, and to do so in such a way that
FRONTPAGE will update them automatically each time the page is saved. Select the Insert
menu and then Date and Time.

| Lir= el Tl __JLE

Display:
{* Date this page was last edited:

" Date this page was last automatically updated

Date format:  |05/20/2002 |

Time format: |(HUI'IE:' ﬂ

oK | Cancel |

Figure 18. The “Date and Time” dialogue.

In this dialogue box, you can select to display the date you last edited the page, or the date
onwhich the page was lastautomatically updated, by clicking the appropriate radio button.
In most cases, you should probably choose the date the page was edited, because your
pages will not be automatically updated. You can then choose the format in which the date
and time of the updates will be displayed by selecting from the drop-down menus.
Generally, a time of update will not be necessary — a date should be sufficient (but note
that in the “Time Format” drop-down, “TZ” denotes “time zone,” expressed as deviation
from Greenwich Mean Time — for example, Eastern Standard Time is “-0500”).

Behaviors
FRONTPAGEincludes a number of what it calls “Web Components.” Most of these are small
JavaScript applications (called “applets”). You should explore using these components in

your web pages; just remember that you can easily begin to clutter your page by putting
in too many of these extra gizmos.

InseniselComponents ﬂ

Component kype: Choose an effect;

B -] [ -
(2 Web Search =
[y Spreadsheets and charts Barner Ad Manager

[i==) Hit Counter

Photo Gallery
% Included Cortert
) Link B
Table of Contents
Top 10 List

Create a button that contains a hyperink to another page, When a visitor mouses over it, the button
zan change color, display 2 picture, or play 2 sound effect,

Find components

grea_| | [

Figure 19. “Web Components”
dialogue.
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Adding hand-coded HTML Features

Sometimes you’ll want to add elements to your web pages that you cannot readily add
through the FRONTPAGE WYSIWYG interface. Fortunately, FRONTPAGE allows you to
modify and include most font attributes within its interface — you simply highlight the
text, click on Format, and Font, then select the attributes you wish to apply (bearing in mind
that not all browsers will display all font attributes).

There are some attributes that you cannot add in this way, however. For example,
you will note that in the font dialogue box, “blink” is greyed out — you cannot choose it.
Of course, “blink” is a text attribute that can only be displayed by Netscape
COMMUNICATOR 4.x browsers. If you think your audience is likely to be using these
browsers, you can click on the HTML tab at the bottom of the FRONTPAGE screen, find the
text you want to blink and insert the following code around it:

<blink>This is the text that will blink.</blink>

This code will make the text between the two tags blink in Netscape.

A more advanced instance of directly coding your pages is if, for example you do
not want your links to be automatically underlined (as they are by default in all HTML
browsers). To make this change, click on the HTML tab to reveal the source code, find the
tag that says </ head> and insert your curser before this tag. Then add the following code
to the header of your page:

<styl e>
a {text-decoration: none}
</style>

The first line here tells the browser that you're altering the default font style. The second
line tells it which tag you're changing (the “a” — or link) tag, and how you're changing it
(you want no text decoration for your links, rather than the standard underlining). The
third line tells the browser that you're done altering the style. Of course, you can substitute
other text decorations for the “none,” like “overline” or “strikethrough” — these will place
a line over your link or through the middle of its text, respectively. If your audience is
likely to have Netscape 4.x browsers, you can even insert “blink” instead of “none” here,
and your links will blink.

Remember, though, that this sort of thing contributes to the general busy-ness of a
page and may be construed by your audience as clutter — which we know by now is to be
avoided at all costs.
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